# Table of Contents

## Part I Introduction

## Part II Getting Started

1. Notice ................................................................................................................................... 5
2. Installing Qwizdom Actionpoint ............................................................................................ 6
3. Hardware Setup ...................................................................................................................... 7

## Part III Actionpoint

1. Overview ................................................................................................................................... 9
2. Slides ....................................................................................................................................... 11
3. Print Presentation .................................................................................................................... 17

## Part IV Participant Lists

1. Participants ............................................................................................................................. 18
2. Group Management ................................................................................................................ 21

## Part V Hardware

1. RF Remote Setup .................................................................................................................... 22
2. Notice ....................................................................................................................................... 26
3. Q2RF ........................................................................................................................................ 28
4. Q4RF ........................................................................................................................................ 30
5. Q5RF ........................................................................................................................................ 32
6. Q6RF ........................................................................................................................................ 35
7. Q7RF ........................................................................................................................................ 39

Using the Pen .......................................................................................................................................................... 40
Speaker Notes ....................................................................................................................................................... 41

## Part VI Presentations

1. Presentation Setup ................................................................................................................... 45
2. Presentation Features ................................................................................................................ 52
3. Remote Login ............................................................................................................................ 55
4. Using Remotes in Presentation ............................................................................................... 57
5. Presenting with QVR ................................................................................................................ 62
6. Presenting with Collaboration .................................................................................................. 65
7. Response Graph ....................................................................................................................... 68
8. Games ......................................................................................................................................... 73
9. Saving Results ............................................................................................................................ 76

Qwizdom Actionpoint User Guide
Revised 2016
## Contents

<table>
<thead>
<tr>
<th>Part VII Reports</th>
<th>77</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Merging Results</td>
<td>79</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Part VIII Answer Key</th>
<th>80</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Part IX Survey Bar</th>
<th>83</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Part X Qwizdom Tools</th>
<th>84</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Part XI Hot-Key Editor</th>
<th>87</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Part XII Troubleshoot</th>
<th>91</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Installing USB Drivers</td>
<td>91</td>
</tr>
<tr>
<td>2 Uninstalling Software and Hardware</td>
<td>93</td>
</tr>
<tr>
<td>3 Toolbar Not Appearing</td>
<td>94</td>
</tr>
<tr>
<td>4 Retrieving Error Logs</td>
<td>95</td>
</tr>
</tbody>
</table>
1 Introduction

This is a user guide for the **Qwizdom Actionpoint**. This guide provides information and tips on using **Qwizdom Actionpoint**.

If you need assistance, please contact **Technical Support**.

**Website**    qwizdom.com/supportcenter

**Email**      support@qwizdom.com
2 Getting Started

Contents of Remote Set
Q2RF, Q4RF, or Q6RF Remotes*
1 HID (Black) Host/Receiver
1 Q6iRF Instructor Remote or 1 Q7RF Instructor Tablet*
1 Charger (Q7RF Instructor Tablet)*
1 Screwdriver
AA Batteries (Q4RF & Q6RF) or AAA Batteries (Q2RF)*
1 Carrying Case

*Remote types and accessories based on actual order. This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.
2.1 Notice

Notices of Compliance for Qwizdom's RF Response Devices

Note: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

Caution: Changes or modifications to Qwizdom's RF hardware that are not expressly approved by Qwizdom could void the user's authority to operate the equipment.

Europe Only

This product is designed for the 2.4 Ghz WLAN network throughout the EC region and Switzerland with restrictions in France.
2.2 Installing Qwizdom Actionpoint

System Requirements
- Vista, Windows 7, Windows 8, or Windows 10
- MS Office 2003 (SP2), 2007 (SP2), 2010, 2013 or 2016
- Adobe® Flash Player
- Open USB Port
- Qwizdom Host / Receiver: version .938 or higher

Installing Qwizdom Actionpoint

Microsoft PowerPoint 2003 (or later) must be installed before installing Qwizdom Actionpoint. Before installing the software on a PC, make sure that all available Microsoft Windows and Office updates have been installed on your computer. If you have an older version of Qwizdom Actionpoint on your computer, uninstall the program through the computer's Control Panel. (If you have an older Red RF Host, be sure to plug it into the USB port before installing Actionpoint. See Hardware Setup for details.)

1. Download the latest version of Actionpoint at http://qwizdom.com/support/actionpoint/#Downloads
2. Open and run the downloaded ActionpointSetup.exe file, then follow the prompts of the Install Wizard.
3. Click Next. The Select Installation Folder section appears.
4. You have the option to select the location of where you would like Qwizdom Actionpoint, or use the default location.
5. Click Next to begin the installation. This will take a few moments.
6. Three icons will appear on your desktop, once installation is complete.
   - **Actionpoint**: create interactive PowerPoint presentations.
   - **Survey Bar**: survey your audience using an application of your choice.
   - **Answer Key**: present and grade paper tests and activities.
2.3 Hardware Setup

1. **Q2 Remotes** - place two AAA batteries and insert the screw (optional) into the back of the remote.

2. **Q4 Remotes** - place two AA batteries and insert the screw (optional) into the back of the remote.

3. **Q5 Remotes** - plug the Q5RF participant and instructor remotes into the multi-charger and/or single charger for 24 hours before first use.

4. **Q6 Remotes** - place two AA batteries and insert the screw (optional) into the back of the remote.

5. **Q7 Presenter Tablet** - the tablet needs to be charged a full 24 hours for the first time or after a long period of inactivity. The pen may take slightly longer to fully charge. Generally, the tablet will only need to be charged about 6 hours to be fully charged after the initial charge. To charge the pen and tablet, place the pen into the pen tray located at the top of the Q7RF Tablet. Using the USB cable, plug the tablet into the computer. The battery icon will be full when the tablet is fully charged.

**If your computer goes into power saving mode, the charging of the Q7RF Tablet may be interrupted.**

**Installing the HID (Black) Host/Receiver**

1. The HID Host is located in the back compartment of the Q7RF Tablet or in the front pocket if remote bag.
2. Plug the HID Host into an open USB port on the computer.
3. The computer will automatically detect and configure the new hardware device.

**Installing the RF (Red) Host/Receiver**

*This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.*
The USB Drivers are located in the Actionpoint installer and should auto-install if it detects the Red RF Host. Plug the USB cable into the RF Host and then plug the other end of the USB cable into an open USB port before installing Qwizdom Actionpoint. If drivers do not automatically install, see *Installing USB Drivers* to manually install USB Drivers.
3 Actionpoint

3.1 Overview

To open Actionpoint, double-click the shortcut icon on your desktop.

Microsoft PowerPoint® will open displaying the Qwizdom Actionpoint toolbar.

Office 2003-2007

From left to right:
- **Present Icon** - starts a presentation
- **Insert Slide** - creates a new slide
- **Question** - displays slide type
- **Type** - number of choices (applicable depending on question type)
- **Answer** - correct answer or None for survey
- **Advanced Options** - send text questions to Q6/QVR during a presentation or set advanced grading/answer options
- **Points** - number of points awarded for correct response
- **Timer** - allows slide to be viewed in presentation for time that is set
- **Configuration Settings** - remote setup
- **Participants** - creates, modifies, imports participant lists
- **Reports** - uploads saved presentation results to generate reports
- **Settings** - additional options for Actionpoint
- **Standards** - add standards to an activity
- **About** - displays software version number and user guide

Office 2010 or later

From left to right:
- **Insert Slide**: Use this feature to add slides to your presentation.
**Question Type:** Set your question type and preferences using this feature.

**Answer/Points/Timer:** In these fields, designate an answer, allocate points, and indicate whether a question has a time limit.

**Question Properties:** Set advanced question properties (Q6/QVR only).

**Start Presentation:** Click this button to access presentation setup options and to run the presentation.

**Advanced Session:** Resume a previous presentation or begin in self-paced mode.

**Participants Management:** Create and modify participant lists.

**Report Generator:** Browse for and view existing reports.

**Remote Configuration:** Set up your remotes for first-time use (not required for subsequent use).

**Standards and Categories:** Assign state or national academic standards to selected slides.

**Qwizdom Tools:** Merge results files, edit speaker notes (Q7), set up Quandary game options, and print a question overview.
3.2 Slides

Available Question Slide options are based on type of Remotes selected in the Configuration Settings window.

Multiple Choice Slides

1. Click the Insert Slide drop-down menu and choose the appropriate multiple choice option. The template appears on the slide.
2. Enter content onto the slide.
3. Click the Answer drop-down menu and select the correct answer.
4. Click the Advanced Options button to view advanced grading options and/or to send question text to Q6RF remotes, while in presentation mode.
5. Click the Points drop-down menu and select the point value or type in the desired point value and press the Enter key on the keyboard to apply the point value to the slide.
6. Click the Timer drop-down menu and select the time or type in the desired time limit and press the Enter key on the keyboard to apply the time to the slide.

Yes/No & True/False Slides

1. Click the Insert Slide drop-down menu and select the type of slide you want to create. The template appears on the slide.
2. Enter content onto the slide.
3. Select the answer from the drop-down menu.

4. Click the Advanced Options button to send question text to Q6RF remotes, while in presentation mode.

5. Click the Points drop-down menu and select the point value or type in the desired point value and press the Enter key on the keyboard to apply the point value to the slide.

6. Click the Timer drop-down menu and select the time or type in the desired time limit and press the Enter key on the keyboard to apply the time to the slide.

**Numeric Slides**

1. Click the Insert Slide drop-down menu and select Numeric. The template appears on the slide.

3. Enter content onto the slide.

4. Click the Advanced Options button. This brings up the Question Properties window.

5. Enter the answer/s and point value.
   - Send Question Text to Remotes-check to send text to Q6RF remotes.
   - Numeric - Select Numeric to add in standard numeric answer/s. (Optional) Enter in multiple answers and point values to give students partial credit. (Optional) Check the Convert fractions to numbers box to allow both fraction and decimal answers to be counted as correct. If this box is unchecked only the answer that is typed into the above field will be counted as correct.
   - Numeric Range - Select Numeric Range to add an answer for rounding, number set, algebraic and other problems with a varying answer range.
   - Require Precision- Sets a place value to which answer/s need to be rounded.

6. Click the Timer drop-down menu and select the time or type in the desired time limit and press the Enter key on the keyboard to apply the time to the slide.

**Sequence Slides**

1. Click the Insert Slide drop-down menu and select the appropriate Sequence option. The template appears on the slide.

2. Enter content onto the slide.

3. Click the Advanced Options button. This brings up the Question Properties window.
   - Check the Send Question Text to Remotes box to send question text to Q6RF remotes.
   - Enter in answer and point value.
   - Check the Give 1 Point for every item in the correct position box, to apply partial grading.
• Click OK when finished.
4. Click the Timer drop-down menu and select the time or type in the desired time limit and press the Enter key on the keyboard to apply the time to the slide.

Multiple Mark Slides

1. Click the Insert Slide drop-down menu and select the appropriate Multiple Mark. The template appears on the slide.
2. Enter content onto the slide.
3. Click the Advanced Options button. This brings up the Question Properties window.
   • Check the Send Question Text to Remotes box to send question text to Q6RF remotes.
   • Select the correct answers and enter a point value.
   • Check the Give 1 Point for every item in the correct position box, to apply partial grading.
   • Click OK when finished.
4. Click the Timer drop-down menu and select the time or type in the desired time limit and press the Enter key on the keyboard to apply the time to the slide.

Use the Multiple Mark option to tally results by exact answer. For instance the results graph will show all participants who answered AB, BC, etc. Use the Vote Multiple Mark to tally results by total votes cast for each option. For instance, the results graph will show that 200 participants voted for A, 100 for B, etc.

Rating Scale Slides

1. Click the Insert Slide drop-down menu and select the appropriate Rating Scale option. The template appears on the slide.
2. Enter content onto the slide.
3. You can set a correct answer by clicking in the Answer field and typing in the correct answer and pressing Enter when finished.
4. Click the Advanced Options button. To send text to Q6 participant remotes.
5. Click the Points drop-down menu and select the point value or type in the desired point value and press the Enter key on the keyboard to apply the point value to the slide.
6. Click the Timer drop-down menu and select the time or type in the desired time limit and press the Enter key on the keyboard to apply the time to the slide.
Text Input (For Q5RF & Q6RF remotes and QVR App)

1. Click the Insert Slide drop-down menu and select Text Input. The template appears on the slide.
2. Enter content onto the slide.
3. Click in the Answer field and type in correct answer. Press Enter when finished.
4. Click the Advanced Options button to send question text to Q6RF remotes and set advanced grading options.
5. Click the Points drop-down menu and select the point value or type in the desired point value and press the Enter key on the keyboard to apply the point value to the slide.
6. Click the Timer drop-down menu and select the time or type in the desired time limit and press the Enter key on the keyboard to apply the time to the slide.

Best used for single word responses where capitalization does not matter.

Text Response, Text Edit, and Equation (For Q6RF remotes and QVR App)

1. Click the Insert Slide drop-down menu and select the type of slide you want to create. The template appears on the slide.
2. Enter content onto the slide.
3. Click the Advanced Options button to enter answer, send question text to Q6RF remotes while in presentation mode, and set grading options.
4. Click the Timer drop-down menu and select the time or type in the desired time limit and press the Enter key on the keyboard to apply the time to the slide.

Best used for short phrase responses, feature allows for punctuation, spacing, and other advance grading options.

Demographic Slides
These slides allow you to categorize results based on location, ethnicity, gender and more.

1. Add a Demographic slide to the beginning of your PowerPoint presentation. Click the Insert Slide drop-down menu and select Demographic. Using the drop-down menu, select the appropriate demographic. The template appears on the slide.
2. Enter content on slide.
3. Set timer, if needed.
4. Start a presentation. Participants will input their demographic data by selecting the appropriate numeric choice.
5. Pose a question slide. Once participants have responded, click on the public graph button on an instructor device or the Reports icon on the Qwizdom Toolbar to bring up the results graph. Click the Demographics icon to view responses to question slides based on set demographic.

Sample:

![Question Slides Example](image)

How do you get to work?

A) Ride public transportation
B) Walk
C) Bicycle
D) Drive an automobile

Note: Toggle between multiple demographics by using the ratio buttons on the results graph.

6. Post-session, click the Reports icon and select the Question Summary Report (with Answer) or Question Summary Report (without Answer) report.

7. Click the Demographics icon to view responses to question slides based on set demographic.
Report Sample

Question Number 2

How do you get to work?

A) Ride public transportation
B) Walk
C) Bicycle
D) Drive an automobile
3.3 Print Presentation

The Print Presentation feature allows you to view a question summary report of an Actionpoint presentation.

1. Open a presentation.
2. Click on Quizdom Tools and select Print.
3. The Presentation Answer Report appears and will display the name of the presentation, number of questions, question number with the question type, answer, actual slide number, and point value.

4. The presentation report can be saved as a .CSV or .PDF.
4  Participant Lists

4.1  Participants

Creating a Participant List

1. Click Participants Management and choose Participant Wizard.
2. Select Create New Participant List.
3. Enter a name for the class and click Next.
4. In the Template Selection, select the template you would like to use (optional) and then click Next. Templates are commonly used fields to allow you to customize a participant list. Select the different fields you would like to use and click Next. If you do not see a field you would like in the participant list, you can create a customized field and add it to your template.
5. Fill in the fields and click on Finish.
   - Pick Chance: Adjust the number to increase a student's chance of being called on when using the Pick participant feature. See Presentation Features for details.
   - Ability Rating: Allows you to group students based on ability in the Group Management section. See Groups for details.
6. The Save As window will open. Click Save and the participant list will save as a .QPL file.

Importing a .CSV (Comma Delimited) File

You can import a .CSV (comma delimited) file and convert it into a Qwizdom participant list (.QPL).

⚠️ If you have a class list in Microsoft Excel® you would like to import, save them as .CSV(comma delimited) file.

1. Click Participants Management and choose Participant Wizard.
2. Select Import from a .CSV file.
3. Click Browse, select the appropriate .CSV file and then click Next.
4. Match the fields to the appropriate item by clicking in the Maps to: column and selecting the desired item from the drop-down list.
   - Click Add Field to create a custom item to the list.
   - Click First record is header, if your CSV file has column headers.
   - Click OK to complete.
5. Click Finish and the Save As window will appear.
6. Type in the class name and click on Save. The .CSV class will save as a .QPL file (Qwizdom Participant List).
Creating an Anonymous List
Before using an anonymous list, be sure you have the correct estimated number of remotes set within the Configuration Settings window. For example, if you create an anonymous list with a hundred participants but only have eighty as the estimated number of remotes, then not all remotes will register.

1. Open a PowerPoint® presentation that has been properly formatted with the Qwizdom Actionpoint toolbar.
2. Click the Start Presentation button. The Presentation Setup window will appear.
3. Click the Participant List drop-down list and select Anonymous.
4. Click OK to begin presentation.

Creating a Self-Forming List
This option lets participants add themselves to list during a live presentation. Participants are identified by an unique User ID number. We recommend using an assigned employee or student ID number for easier tracking.

1. Open a PowerPoint® presentation that has been properly formatted with the Qwizdom Actionpoint toolbar.
2. Click the Start Presentation button. The Presentation Setup window will appear.
3. Click the Participant List drop-down list and select Self-Forming List.
4. Select a location to save results and select desired presentation settings.
5. Click OK to begin presentation.
6. Users will be prompted to enter a User ID. They may be asked to enter it twice to confirm. Participants will be identified by their User ID numbers throughout the session.
7. You can view students' answers, post-session, by clicking on the Report Generator icon on the toolbar, browsing to the results file, and selecting Answer Report.

<table>
<thead>
<tr>
<th>Participant Name / Score / Spont. Score / Average</th>
<th>Q1</th>
<th>Q2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Participant 12</td>
<td>0 %</td>
<td>0 %</td>
</tr>
<tr>
<td>Participant 13</td>
<td>0 %</td>
<td>0 %</td>
</tr>
</tbody>
</table>

Editing an Existing Participant List
1. Click Participants Management and choose Participant Wizard.
2. Select Browse and Modify Existing List.
3. Click Browse, select the appropriate participant list and then select Open.
4. Add new fields or remove existing fields. If you do not want to change anything, skip to the next step.
5. Make the necessary changes.
   • **Delete Students:** Select the row by clicking in the cell to the far left, then go to Options and select Delete.
   • **Renumber Remotes:** Use the Options menu and select Autonumber Remotes.
6. Click Finish when done. The Save As window will appear.
7. Enter the name of the class and click Save.
4.2 Group Management

Automatically create groups. Groups can be used in when playing Quandary. See Games for details.

1. Click on Participants Management and select Group Management.

2. Select the Grouping Action:
   - **Balance**: Creates balanced ability groups from either the Predefined Ability Ratings (set in the participant list) or scores from a selected activity.
   - **Group Similar**: Groups students with similar Ability Ratings (set in the participant list) or scores from a selected activity.
   - **Random**: Groups students randomly, no ability rating settings are needed.

3. Set the size of group and click Generate.
4. Review and modify as desired, by dragging students into different groups.
5. Click OK when finish.
5 Hardware

5.1 RF Remote Setup

If setting up remotes for the first time we recommend the following steps. Note: You will only have to do this once. Be sure the HID (black) host, or RF (red) host is properly installed and plugged in before proceeding. (See Hardware Setup for details.)

1. Click Remote Configuration.

![Remote Configuration settings](image)

2. Type in the number of remotes in your set(s).
3. Select only the remote types you are using.
4. Select your preferred configuration. Use Fixed Set unless the remotes are participant-owned. See below for details.
5. Click OK to finish. Newer remotes, received in 2012 or later, already come with pre-assigned numbers, matching their affixed stickers, so no further action is required. If you have older Qwizdom Response hardware, received in 2011 or earlier, click the Assign button. Read the dialog box, and click OK to start assigning Remote ID numbers. (See Assign Remote IDs below for details.)

Other Settings & Explanations:

- **Enable Backlight** - activates the backlight on the Q5RF Participant and Q5RF Instructor Remotes.
- **Using Q4 Remotes older than version 1.34** - check this to assign Remotes ID numbers to older Q4s. To check the version number, turn on a Q4 remote by
holding down the Menu key. The version number will appear on screen.

- **Fixed Set**—Remotes are configured to always look for a Fixed Session ID (host/receiver number). Additionally each remote will store a Remote ID number, so participants can simply turn on a remote to join a session.

- **Roaming Set or Participant Owned**—check this option if the participants own the remotes. This mode is best-suited for Higher Ed/University settings. Participants are typically required to enter a Session ID and Participant ID to join a presentation.

### Assign Remote IDs

**Remotes received in 2011 or earlier** need to be set up once, prior to use, with computer-assigned ID numbers. Newer remotes, received in 2012 or later, already come with pre-assigned numbers, matching their affixed stickers, so no additional setup is required.

1. Plug in your host.
2. In the Configuration Settings window, select *Fixed Set* and click the *Assign* button.
3. In the Remote Assignment window, check *Auto-Increment Remote Number* to assign numbers in the order in which remotes are turned on.
4. Click *Detect*, then *Start*.
5. The Session ID field will automatically populate (if your host is plugged in). This is your host’s unique 6-digit identifier.
6. Begin turning on your remotes. When a remote connects with the host, its assigned ID number will appear on the remote’s display.
7. If your remotes do not connect, they are not configured with the correct Session ID. Please see **Changing Session IDs** below.
8. Click *Stop* when all remotes have been assigned. Your remotes will turn off automatically.
9. This process only needs done once—the assigned number will remain fixed with that remote. If desired, use a marker, or affix a sticker, to designate the number that has been assigned to that remote.

### Assign Remote IDs Q4 Remotes Older Than Version 1.34

The following directions only apply for customers on a PC, using Q4 remotes older than version 1.34. To check the version number, turn on a Q4 remote by holding down the Menu key. The version number will appear briefly on the screen. If your Q4 version number is less than 1.34:

1. Insert host into the USB port of your computer.
2. Click on the *Qwizdom Tools* icon (in tray at the bottom of your computer screen).
3. In the Tools window, click *Utilities*, then *Configuration Settings*.
4. In the Configuration Settings window, check the box for *Using Q4 Remotes Older Than Version 1.34*.
5. Select *Fixed Set*, and click *Assign*. 
6. Select your type of host from the drop-down.
7. When the Session ID field populates, click Start, then begin turning on your remotes, beginning with the instructor device. When a remote connects with the host, its assigned ID number will appear on the remote’s display.
8. Click Stop when all remotes have been assigned. Remotes will turn off automatically.
9. This process only needs done once—the assigned number will remain fixed with that remote. If desired, use a marker, or affix a sticker, to designate the number that has been assigned to that remote.

Changing Session IDs
If the RF remote displays No Net, Not Found, Not Active, or Inactive, it could be that the Session ID is not correct.
- **For Q2RF remotes:** wait for the remote to time out and turn off. When you turn it back on, press the Help (Hand)key. When you see --S on the display, it is prompting you for the Session ID. Enter it and press the Join key to confirm.
- **For Q4RF remotes:** press the Menu key, use the right arrow to scroll to Sess. ID., and press the Send (double arrows) key to select the option. You will see the current Session ID and will be asked if you want to change the Session ID. Press T (Yes) to change. Enter the Session ID and press the Send key.
- **For Q5RF remotes:** wait for the remote to display No Net, Not Active, or Not Found. Press the Menu key and select Enter Session ID by pressing the Send (double arrows) key, enter the Session ID and press the Send key.
- **For Q6RF remotes:** press the Menu key, scroll to Enter Session ID, press the Menu Select key, reenter the Session ID, and press the Search Again key.
- **For Q7 Tablet:** press the Menu key and use the Scroll button to scroll to Enter Session ID. Press the Enter key to select, use the A button to delete the Session ID and then reenter the Session ID. Press the Enter key to confirm.

What is a Session ID?
Each host/receiver has a unique six-digit, Session ID number. Session IDs "assign" the remote to the host, allowing the remote to only communicate with that specific host.

The Session IDs can be found:
- For both HID and RF Host, the Session ID can be found in the Remote Assignments window, the Device Settings tab in the Presentation Setup window, and the Login tab of the Qwizdom Toolbar during a presentation. Session ID is also displayed at the top of the Qwizdom Tools menu: click Qwizdom Tools, found in the lower right-hand corner of the Windows Taskbar (next to the clock).
- For the RF (Red) Host, the Session ID is printed on a white sticker affixed to the bottom of the device.
You can also create your own Session ID in the Presentation Setup window. Creating your own Session ID does not change the host’s default Session ID. See Presentation Setup for details. The Session ID must be unique because if there are other hosts in the same building, the remotes will become confused about the host with which they are to communicate.
5.2 Notice

FCC 15.19:

(3) All other devices shall bear the following statement in a conspicuous location on the device.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

FCC 15.21:

The user's manual or instruction manual for an intentional or unintentional radiator shall caution the user that changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to operate the equipment. In cases where the manual is provided only in a form other than paper, such as on a computer disk or over the Internet, the information required by this section may be included in the manual in that alternative form, provided the user can reasonably be expected to have the capability to access information in that form.

FCC 15.105:

(b) For a Class B digital device or peripheral, the instructions furnished the user shall include the following or similar statement, placed in a prominent location in the text of the manual:

NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is not guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

-- Reorient or relocate the receiving antenna.
-- Increase the separation between the equipment and receiver.
-- Connect the equipment into an outlet on a circuit different from that to
which the receiver is connected.
-- Consult the dealer or an experienced radio/TV technician for help.
5.3  Q2RF

Participant Remote

1. **E ink™ display**-displays the remote's ID number when it is turned off; displays remote's ID number and battery icon when it is turned on.

2. **Navigation** arrows-scroll through questions when taking an AnswerKey.
   - Left arrow is also used as a backspace.

3. **True/Yes, False/No** keys-use to answer True/False and Yes/No questions.

4. **Multiple Choice and Numeric** keypad-answer multiple choice and numeric questions (with single digit answers).

5. **Join** key-press to turn remote on/off or confirm Session and/or User IDs.

6. **Help** key-press to request assistance or press to change Session ID when the remote cannot find the host.

**Q2 Common Screen Displays**

- **A**: Enter Activity ID.
- **S**: Enter Session ID.
- **U**: Enter User ID.
- **-- --**: Remote cannot find host and will power down.
- - : Remote is searching for the host.
   : Battery icon indicates battery charge when remote is on.

**Supports the Following Question Types:**

- Multiple Choice
- True/False
- Yes/No
- Single Digit Numeric
- Rating Scale (1-5) and (1-7)

*This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.*
5.4 Q4RF

Participant Remote

1. **Send** key-press to submit answer or select menu options.
2. **Menu** [power] key-press to view menu options (use the scroll `<>` keys to scroll through options and press Send `Esc` key to select the option). Holding the Menu key for two seconds will turn the remote on/off. Turn off remotes if they are not in use. Remotes automatically turn off at the end of a PowerPoint® presentation. **Search**, **Sess. ID**, **User ID**, and **Exit** are options available in the Menu. When you're in presentation, the menu items are **Help**, **Login**, **User Id**, and **Exit**. To request help during presentation, press the **Menu** key, scroll to select **Help**, and press the Send `Esc` key to select it.
3. **Scroll** `<>` keys-scroll through menu options, answer choices, or question numbers.
4. **Clear** [C] key-press to delete response or change answers if instructor has enabled the feature.
5. **True/Yes** and **False/No** keys—use to answer True/False and Yes/No questions.

**Q4 Common Screen Displays**
- **Qwizdom**: Remote has found the host and is ready for a question slide.
- **Activity ID**: Displays when the remote is requesting an Answer Key activity number. Prompt only appears when multiple test versions are being presented. Activity numbers should be noted on the test sheets before presenting; numbers cannot be viewed while in presentation mode.
- **Loading**: An Answer Key is loading; may take a few moments.
- **Push Key**: Remote is idle. Press any key, (except MENU) to reactivate.
- **Inactive**: Remote senses the host is not in use or does not recognize the session. If remote remains inactive after starting a presentation, reenter Session ID by pressing MENU, scrolling right to "Sess.ID," and pressing SEND. When prompted, reenter the Session ID and press SEND.
- **No Net**: Remote cannot find the host. Reenter the Session ID. If "No Net" continues, enter User ID and Session ID.
- **Denied**: User denied due to incorrect User ID or a duplicate User ID. Reenter User ID. Press MENU, scroll to "User ID," press SEND, enter the User ID, and press SEND again.

**Supports the Following Question Types:**
- Multiple Choice
- True/False
- Yes/No
- Single and Multi-Digit Numeric
- Rating Scale
- Negative Number, Fractions & Decimal
- Multiple Mark
- Vote Multiple Mark
- Sequence
- Demographic

*This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.*
5.5 Q5RF

Participant Remote

1. **Send** key-press to submit answer.
2. **Clear** [C] key-press to delete response or change an answer in a presentation (if option to change responses is allowed)
3. **Thumb pad**-press to navigate between letters when keying in answer, press the circle key in the middle to select a letter or to select menu options or to scroll through question numbers during answer keys (paper-based tests).
4. **Question** [?] key-signals help to instructor during presentation.
5. **Menu** key-displays menu options Search Again, Enter Session ID, and Exit. Use the thumb pad to scroll through the menu options and the **Send** key or circle key to select an option.
6. **True/Yes** and **False/No** keys-use to answer True/False and Yes/No questions.
7. **Power switch**-turns remote on/off. The remotes do not automatically turn off. Turn off remotes if they are not in use.
8. **Backlight switch**-turns Backlight on/off.

**Supports the Following Question Types:**
- Multiple Choice
- Yes/No
- True/False
- Numeric
- Sequence
• Multiple Mark
• Vote Multiple Mark
• Rating Scale
• Text Input
• Demographic

Instructor Remote

1. **Send** key-press to submit command.
2. **C [Clear]** key-press to clear names from the Help Request list.
3. **Thumb pad**-press right/left to navigate between slide sets, up/down for menu options, and "on-the-fly" question choices. Press the circle key (in the middle) to select an option, play Microsoft PowerPoint® animations, advance slides, exit the presentation, and show/hide correct responses on the response graph.
4. ? [Help List] key-displays list of participants who requested help on the LCD screen.
5. **Menu** key-view menu options such as entering Session ID and search again for host.
6. **True/Right** and **False/Wrong** keys-not applicable using Qwizdom Actionpoint.
7. **New Q [-]** key-press to pose an "on-the-fly" question.
8. **Pick** [] key-press to display/hide a random participant’s name on the computer screen.
9. **Private Graph** [0] key-displays the results of the class responses as a graph on the LCD screen of the instructor’s remote.
10. **Public Graph** [/] key-displays the results of the class responses as a graph on the computer (projector, television screen, etc.) screen for everyone to view. Use the right/left controls on the thumb pad to scroll through the different graphs.
Use the circle key (in middle of thumb pad) to show/hide correct responses.

11. **Show [7]** key - to show current scores and start game animations during game mode.

12. **Play [8]** key - not applicable

13. **Fn** (Function) key - allows you to re-pose a question if you go back to a previous slide during presentation. Note: previous answers will be overwritten.

14. **Power switch** - turns remote on/off.

15. **Light switch** - turns Backlight on/off. The "Enable Backlight" box in the Configuration Settings window needs to be checked to turn on the Backlight feature.

**Q5RF Common Screen Displays**

- **Qwizdom**: Displays when slides are non-question types, such as lessons or information.

- **Activity ID**: Displays when the remote is requesting an Answer Key activity number. Prompt only appears when multiple test versions are being presented. Activity numbers should be noted on the test sheets before presenting; numbers cannot be viewed while in presentation mode.

- **Loading**: An answer key is loading; may take a few moments.

- **Push Key**: Remote is idle. Press any key, (except MENU) to reactivate.

- **Inactive**: Remote senses the host is not in use or does not recognize the session. If remote remains inactive after starting a presentation, reenter Session ID by pressing MENU, scrolling right to "Sess.ID," reentering Session ID, and pressing SEND.

- **No Net**: Remote cannot find the host. Reenter the Session ID. If "No Net" continues, enter User ID and Session ID.

- **Denied**: User denied due to incorrect Session ID, User ID, or a duplicate User ID.

- **Ready**: Displays on the instructor remote is ready to use.

- **Last Key**: Will appear on the instructor's remote showing the last key that was pressed.

*This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.*
5.6  Q6RF

Participant Remote

1. **Menu/Power** - press and hold on to power remote on/off. Press to view menu options: Help, Search, Sess. ID, User ID, Adjust Contrast, and Exit.
2. **Enter** - press to submit commands from LCD menu choices.
3. **Directional Arrows** - press to navigate between menu options, answer choices, and questions.
4. **Multi-function** - serves as multi-function for Send/Change.
5. **Symbols** - select to enter fraction, punctuation, etc.
6. **Delete** - press to delete the last character.
7. **Q#** - displays the current question number.
8. **Help Request** - indicates your requested help.
9. **Battery Power** - displays battery charge.
10. **ID#** - displays the remote ID number.
11. **Right/Wrong Feedback** - displays check mark for correct answer, X for incorrect
answer, and both check mark/X for response received.

12. **Shift**-changes case options: ABC/Abc/abc/123/Superscript/Subscript.

**Q6 Common Screen Displays**

- **Searching for Session ID:** Remote is searching for the host.
- **Ready:** Remote has found the host and is ready for a question slide.
- **Power Save Mode:** Remote is idle. Click RESUME, to reactivate.
- **Help:** First available Menu option. With Help selected, press the menu select key 🖋 to privately ask for help or scroll to "EXIT" and press 🖋.
- **Session ID Not Found:** Remote cannot find the host. Reenter the "Session ID." Press MENU, scroll to "Enter Session ID," click 🖋, enter the Session ID, and press SEARCH AGAIN.
- **Session ID Login Denied:** User denied due to incorrect User ID, or a duplicate ID. Reenter User ID. Press MENU, scroll to "Enter User ID," click 🖋, reenter the User ID, and press JOIN.
- **Enter User ID:** Requesting a User ID number. "Require login by ID" option must be selected in Presentation Setup window to use this optional login method.
- **Loading:** Loading an Answer Key; may take a few moments.
- **Enter Activity ID:** Requesting an Answer Key activity number. Prompt only appears when multiple test versions are being presented. Activity numbers should be noted on the test sheets before presenting; numbers cannot be viewed while in presentation mode.

😂 **To send question text to Q6RF remotes click on the 🖋 Advanced Options button and check the Send Question Text to Remotes box. See Slides for details.**

**Supports the Following Question Types:**

- Multiple Choice
- Yes/No
- True/False
- Numeric
- Sequence
- Multiple Mark
- Vote Multiple Mark
- Rating Scale
- Text Input
- Text Response
- Text Edit
- Equation
- Demographic
Q6i RF Instructor Remote

1. **On/Off**: Press and hold to turn remote on/off. Press to view menu options: Enter Sess. ID, Enter User ID, and Backlight.
2. **Directional Arrows**: Press to navigate between slides and press ⬅️ to select LCD menu choices.
3. **Full List**: View all available actions.
4. **Pick**: Randomly call on a participant.
5. **Private LCD Graph**: Display a response graph on the Instructor Remote’s LCD.
6. **Public Screen Graph**: Display the response graph for everyone to view.
7. **Re-pose Question**: Re-pose the current question slide.
8. **Help Menu**: Display a list of participants who request help.
9. **New Q**: Pose a spontaneous question.
10. **Space**: Add a space when typing a question.
11. **Pick (Special)**: Select a participant at random from a specific group. Groups include answered correctly, not answered on, etc.
12. **Shift**: Changes case options: ABC/ Abc/abc/123/Superscript/Subscript
13. **Symbols**: Press to enter fraction, punctuation, etc.
14. **Delete:** Press to delete the last character.

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.
5.7 Q7RF

Instructor Tablet

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

orical

Pick-picks participants at random

Help Requests-displays a list of participants who have requested help on tablet's LCD screen

Insert Slide-poses a spontaneous question

Pose-re-poses a question

Time tool-adds additional time when using the timer
Stop - stops the question being posed

Private Graph - displays private graph of responses on tablet

Public Graph - displays response graph to participants

LCD Backlight - turns backlight on or off

Pen & Laser Pointer - can be used for annotation (no additional software required). All other annotation tools require WizTeach 3. See Drawing and Editing Tools for details.

Quick Pose Options Click an answer to spontaneously pose a numeric, multiple choice, yes/no, or rating scale question.

1 2 3 4 5 6 7 8 9 0 . / Any For Numeric question types*

A B C D Any For Multiple Choice question types*

Y N Any For Yes/No or True/False question types*

Rate 1-5 For Rating question types

* Click Any to pose a survey question.

5.7.1 Using the Pen

The Pen is used (with the Tablet) to write, draw, and control mouse movements.

Pen Tip - same as a mouse cursor.
Left-click button-same as double-clicking with left button on the mouse.
Right-click button-same as the right-click button on the mouse.

Pen Actions
- **Press, Tap, Push Down with Pen Tip**- activates Tablet icons, similar to left-clicking with mouse.
- **Double tap with Pen Tip**- is similar to double-clicking with mouse.
- **Left-click**- similar to double-clicking with mouse.
- **Right-click**- similar to right-clicking with the mouse.

Sleep Mode
The Pen goes into sleep mode after a minute of inactivity. Touching the pen to the Q7RF Tablet surface or pressing the Left/Right buttons on the pen will reactivate it.

5.7.2 Speaker Notes
Speaker notes allow you to view notes on the Q7 Tablet while in presentation mode.

1. Select a slide to place speaker notes on.
2. Click Qwizdom Tools and select Speaker Notes. The Speaker Notes window appears.
3. Click Insert at Root. Root appears for you to enter text.
4. Enter text.
5. Click Insert to insert a subroot.
6. Enter text.
8. When finished, click close to save the information.
9. Click Save to save the changes.
6 Presentations

Before presenting a PowerPoint® presentation using Qwizdom remotes, please see Presentation Setup to learn about the presentation features.

1. Click the Start Presentation button.
2. The Presentation Setup window appears.

3. Select a Participant List.
4. Select how you would like to save the results.
5. Select the options you would like available during presentation.
7. Click OK to begin the presentation.
8. Have the participants turn on their remotes.
9. Participants enter their response.
10. Here are a few things you may execute during presentation:
    - Display the response chart
    - Display the private graph on instructor device
    - Randomly call upon a participant by pressing the Pick feature
See Using Remotes in Presentation for descriptions and troubleshooting of all the remote LCD screen messages.

11. Go through the presentation until all the question slides are answered.
12. When you are unable to advance to the next slide, this means the presentation is done. Right-click the Q on the Presentation Toolbar and select End Session to end the presentation.

Using Multiple Hosts
Up to 3 hosts (with 999 remotes on each) can be used for presentation for Q2RF, Q4RF, Q5RF and Q6RF.
If you have selected to use fixed set, be sure you have assigned fixed numbers for the remotes using all hosts.

1. Click the Start Present button. The Presentation Setup window will appear.
2. Click the Device Settings tab.
3. Select the hosts you will be using by placing a check mark in each one of the boxes.
4. You can create your own Session ID in the User Session column or use the default Session ID.

   If you use the default Session ID in the Host Session column, the User Session column must be blank.
5. Click OK to begin the presentation.
6. When the presentation appears, turn on the remotes.
7. If you assigned fixed numbers, the remotes will automatically log into the correct host, using the Session IDs used at that time.
8. Either the answer choices or a blank screen will appear on the remote, depending on the question type.

   See Using Remotes in Presentation for description and troubleshooting of all the remote LCD screen messages.
6.1 Presentation Setup

There are many options you can apply to your presentation. Not all options will be applicable.

**Presentation Settings** tab:

1. Select the desired participant list.
   - **Anonymous**: Identifies users by a randomly assigned Participant ID number allowing responses to be anonymous.
   - **Self Forming (Requires User ID Login)**: Identifies user by an assigned Participant ID number for instance an employee or student number. Participant remotes will prompt users to enter a User ID. Reports will tally results based on the Participant ID numbers.
   - **Browse to Participant List (.QPL file)**: Identifies students by name as defined in Qwizdom class list (.qpl).
   - **Blackboard Participant List**: See Quick Start Guide for details.
2. Select where you would like to save your results file.
3. Select how you wish to present the activity.
   - **Normal Presentation**: Present as a PowerPoint Presentation with interactive
presentations.

- **Game Modes:** Select from four game options including Fast Track, Quandary, Mission to Mars, and Baseball.
- **Self-Paced:** Participants work through an Answer Key activity at their own pace. See Answer Key for details.
- **Autopilot:** Automatically cycles through presentation, adding a 15 second timer to each slide.

4. Select *Send Right/Wrong Feedback to Remotes after answering* to notify participants if they answered correctly (indicated by a check mark) or incorrectly (indicated by an X). Remotes will receive both a check mark and X if feedback is turned off, to indicate that the response has been received.

5. Select *Allow participants to change answer* if you would like participants to change their answer during a presentation.

6. Select no timer, use the time set within the slides, or global timer by entering the number of seconds for all slides in the presentation.

**Login tab:**

1. Check the *Require Login by ID* box if you would like students to login using their
Participant ID. Perfect for classrooms where students don't have assigned remotes.

3. Check Show Login Screen to monitor participants logging in. **Tip:** When using QVR, be sure to write down QVR Session number on the board, as it is not displayed in the login screen.

4. Check the Add & Allow Unregistered participants box to allow participants that are not on selected participants list to join the session. This option must be checked when using an Anonymous list.

5. The Deny Login After ... feature restricts participants from logging in after a set amount of time.
**Chart** tab:

1. Select the desired Results Graph layout that will be displayed during a presentation.
2. Check the *Automatically Show Correct Answer on Chart* option to display the percentage and number of correct answers. Click the *Correct Answers* icon to toggle feature on and off during a presentation.
3. Use the *Background Filename* option to select an image to display as the response chart background.
**Device Settings** tab:

![Device Settings](image)

These settings determine how participants may join and interact during a session using a personal device. Participants may collaborate, annotate, take notes, answer questions, request help, and more, depending on the device, application, and license.

**Consumer Devices** refers to any Wi-Fi enabled device that participants may use to join a session, including laptop, tablet, computer, or smart-phone. An additional license (by presenter or participant) may be required in order to join a session.

**Local Communication:** allows users to connect to the session by IP address. All users must be on the same network as the presenter, but no internet access is required. (See [Presenting with Collaboration](#).)

**Web-based Communication:** allows users to connect to the session by a session key. Users can join from anywhere in the world, but internet access is required for the presenter and all participants. (See [Presenting with QVR](#).)

**Qwizdom Hardware** refers to dedicated RF handsets manufactured by Qwizdom. These devices are simple, low cost, and reliable and may be used for polling,
instant assessment, and basic interaction by participants.

Host Session: use the default Host Session ID, or type in a custom Session ID in the User Session field.
(Custom Session ID numbers are a quick fix if you receive a replacement host and haven't had time to re-program your participant remotes.)
Advance Settings link:

- **Ask for confirmation of User ID when not on list** - the remote will prompt the participant for the user ID again, if the participant is not in the participant list that was loaded.
- **Audio Feedback** - notifies users with a tonal indicator that a tool is active when using the Q7 Tablet during a presentation.
- **Don't require "Send" on single key answers** - the remote will automatically send the answer once it has been entered.
- **Do not show what key was pressed on Q2's** - does not show on the display which key was pressed.
- **Turn off remotes on presentation end** - automatically turns off the Q2RF, Q4RF and Q6RF remotes when a presentation ends.
- **Show score on Remote in Self-Paced Mode** - enables final score to display on screen after completing an answer key.
- **Increase Q4 Sleep Time to up to 2 hours** - prevents the Q4s going to power saving mode for up to 2 hours.
- **Disable "Change Session ID" menu during login** - hides the Session ID option from the menu.
- **Disable "Change Session ID" menu during active Session** - hides the Session ID option from the menu during presentation.
- **Forget User ID in Roaming Mode** - requires participants to login by Session ID and User ID each time a new session is started when remotes are set to Roaming. See remote setup for details.
6.2 Presentation Features

Qwizdom Toolbar
There are many ways to customize your Qwizdom presentations. Right-click on the Qwizdom Toolbar to view options menu.

Buzz-In Box/Participant Counter
The Buzz-In Box displays the percentage of participants who have answered.

During a presentation:
1. Right-click the Qwizdom Toolbar and go View/Buzz-in Box to display the percentage.

Timer
Timer displays the remaining time in which participants can submit responses. Add additional time by clicking on the + Add icon.

You can add or remove the timer during a presentation.
1. Right-click the Qwizdom Toolbar and select Settings.
2. Under the Display tab, use the Timer drop-down menu to change the timer settings.
3. Click OK to close and apply changes.

Answer Grid
The Answer Grid indicates participant response by corresponding remote ID numbers.

To Show/Hide the Answer Grid.
1. Right-click the Qwizdom Toolbar and go View/Answer Grid.
2. Right-click Answer Grid to change display settings, including size, number of columns, placement, etc.

Presentation Tools
Use the *Re-pose, Response Graph, Pick,* and *Game/Show* icons when presenting activities using a desktop or laptop.

**Re-posing a Question**
Re-posing is used to ask a question again and/or when you accidentally skip a slide that needs to be answered. Reposing the question overwrites the previous responses if any are recorded.

1. Click the **Re-pose** button to pose the question again.
2. Click the **Re-pose** button again to stop.

**Response Graph**

1. Click the **Response Graph** button.
2. The *Response Graph* appears.
3. Click the **Response Graph** again to remove the graph.

**Picking Participants**

1. Click the **Pick** button to randomly call upon a participant.
2. The participant's name or participant ID appears on screen.
3. Click the **Pick** button again to remove the name.

**Game/Show**
Shows game animation.

1. Click the **Game** button to view game windows, including scores, animations, etc.
Display Session ID During a Presentation

1. Right-click the Qwizdom Toolbar and select the Login tab. The Session ID will appear at the top of the window.

Automatically Show Correct Answer on Response Chart
Displays a fraction and percentage of correct answers. For example: Correct Answer(s) 10/12 83%. To activate this feature during a session, right-click the Qwizdom Toolbar and select Settings. Under the Display tab, select Automatically Show Correct Answer on Chart and then click OK.

Right/Wrong Feedback
This feature allows participants to see if their response is right or wrong. Feedback appears on the LCD screen of the participant's remote during presentation. A check mark will indicate a correct response, an X will indicate an incorrect response. If the feedback is disabled, a check mark and X appears on the LCD screen indicating that a response was received.

You can turn this feature on and off during a presentation by

1. Right-clicking the Qwizdom Toolbar and selecting Settings.
2. Under the General tab, click Send right/wrong feedback.
6.3 Remote Login

Logging in with IDs allows participants to use any remote. The participant is identified by a unique ID number that is set in participant lists. (Go to Participant Lists for more information).

- Participant IDs can only be numeric.
- IDs cannot be used for more than one participant (IDs cannot be duplicated).
- Maximum number of digits allowed for IDs is:
  - 8 for Q2RF remotes.
  - 9 for Q4RF remotes.
  - 8 for Q5RF remotes.
  - 14 for Q6RF remotes.

1. Open a PowerPoint presentation.
2. Click the Start Presentation button. The Presentation Setup window will appear.
3. Select a participant list.
4. Click the Login tab.
5. Check the Require Login by ID option.
6. Check the Show Login Screen, if desired.
7. Check the Add and Allow Unregistered Users to allow participants not on the list to join the session.
8. Select all other preferred options and click OK to present. The presentation will begin.
9. The Q4RF, Q5RF and Q6RF remotes will display User ID. The Q2RF remotes will display --U.
10. Participants will enter their ID and press the Send key.

If Add and Allow Unregistered Users is checked, participants not on the class list may be prompted to enter their User ID twice to confirm.

11. Once everyone has logged in, begin the presentation.
12. You can start the presentation as participants log in. Participants who are late can log in later, if you have not set a timer to deny log in.

Login Timer

You can deny login after a certain amount of time by setting the time under the Login tab.

1. Check the Deny Login After --- Minutes option.
2. Enter the number of minutes that participants have to log in. For example, you have selected to deny log in after 5 minutes. After 5 minutes have passed, participants who try to log in will be denied.
Troubleshooting

1. If the Q4RF remote displays Denied, or the Q5RF remote displays Access Denied, or the Q6RF displays Session ID Login Denied, or the Q2RF remote displays --U, then the Participant ID may have been entered incorrectly.
   - For Q2RF remotes, press the Hand key, re-enter the Participant ID, and press the Join key.
   - For Q4RF remotes, press the Menu key, use the right arrow to scroll to User ID, and press the Send (double arrows) key to select it. Re-enter the Participant ID and press the Send (double arrows) key.
   - For Q5RF remotes, press the C (clear) key, re-enter the Participant ID, and press the Send (double arrows) key.
   - For Q6RF, click the On/Off key select Enter User ID. Scroll to Enter Session ID, press the (Menu) menu select key, re-enter the User ID, and press the Join key.
   - The Participant IDs will be remembered for the session until another participant list is selected.
6.4 Using Remotes in Presentation

**Q6/iRF Instructor Remote Tips**
- The Q6/iRF Instructor Remote will display a list of actions when ready.
- Press the \((3)\) key to display the public response graph. Press again to close.
- Press the \((2)\) key to display the graph on the instructor's LCD. Press again to close.
- Press the \((1)\) key to randomly call upon a participant during presentation. Press again to close.
- Press the \((6)\) key to pose a spontaneous question. A list of question types will appear on the LCD. Use the up/down arrows to navigate through the question types. Press the `Select` key to choose the question type. Enter the correct answer and press `Send`; if the answer is survey only, press the `Send` key without selecting an answer.
- Press the \((5)\) key to display the list of participants who have requested help.
- Press the `Select` key to play PowerPoint animations during a presentation. *

**Q5RF Instructor Remote Tips**
- The Q5RF Instructor Remote will display `Ready` or `Last Key` when it is connected to the host.
- Since the Q5RF Instructor Remote is not applicable during answer keys, the LCD screen will display `Access Denied`.
- Press the `/` key to display the response graph. Press again to close.
- Press the `0` key to display the graph on the instructor's LCD.
- Press the `Pick (.)` key to randomly call upon a participant during presentation.
- Press the `1 (A)` key to bring up window shade.
- Press the `Show (7)` key to show current scores and start game animations during game mode. In Fast Track and Mission to Mars, press the \((1)\) key to move to the next question and press the \((3)\) key to display track.
- Press the `New Q (-)` key to pose a spontaneous question. A list of question types will
Appear on the LCD. Use the up/down arrows on the thumb pad to navigate through the question types. Press the Send key to select the question type. Select the correct answer and press Send; if the answer is survey only, press the Send key without selecting an answer.

- Press the (?) key to display the list of participants who have requested help.
- Press the circle key, in the thumb pad, to close out of the presentation (must be on last slide), play the PowerPoint® animations and schemes (if any were applied), and move to the next slide. *

* Features only work in Actionpoint Software.

Q7 Presenter Tips
- The Q7RF Presenter Tablet will display Ready when it has successfully connected to the host.

- Press to display the public response graph. Press again to close.

- Press to display the graph on the instructor’s LCD.

- Press to randomly call upon a participant during presentation.

- Press to pose a spontaneous question. A list of question types will appear on the LCD. Use the toggle to navigate through the question types. Press the Send key to select the question type. Select the correct answer and press Send; if the answer is survey only, press the Send key without selecting an answer.

- Press to display the list of participants who have requested help.

- Press Show to display game animations.

Participant Remote Tips
- Qwizdom will be displayed on the Q4RF and Q5RF remotes when a lesson (non-question) slide is in view. The Q6RF remote will display Ready when a lesson (non-question) slide is in view.

- For Q4RF, Q5RF and Q6RF remotes, participants will either see answer choices or a blank screen (depending on question type) on their remote during a question slide.
For Q2RF remotes, participants will see a blank screen with a battery icon.

- To request help on the Q4RF and Q5RF press the *Menu* key, select *Help* and then press *Send*. For Q2RF remotes, press the *Help* (Hand) key. For the Q6RF, press the *On/Off* key and then press *Send*.

- To change the Session ID on the Q4RF remote, press the *Menu* key and use the right arrow to scroll through the menu options. When you see *Sess. ID*, press the *Send* key to select it. An existing Session ID may appear and the remote will ask if you want to change it. Press *T* for yes and enter the new Session ID. Press the *Send* key to confirm.

- To change the Session ID on the Q5RF remote, press the *Menu* key when the remote displays *No Host Found*. Use the thumb pad to navigate through the menu options and press the *Send* key to select *Enter Session ID*.

- To change the Session ID on the Q2RF remote, when the remote is on, wait for the remote to time out and turn off. When you turn it back on, press the *Help* key. When you see --S on the display, enter the Session ID and press the *Send* key to confirm.

- To change the user ID on the Q4RF remote, press the *Menu* key and use the right arrow key to scroll to *User ID*. An existing user ID may appear and the remote will ask if you want to change it. Press *T* for yes and enter a user ID. Press the *Send* key to confirm.

- To change the Session ID on the Q6RF remote, press the *Menu* key, scroll to *Enter Session ID*, press the (↓) menu select key, re-enter the Session ID, and press the *Search Again* key.

- The LCD screen on the participant remotes may read *Push Key, Inactive*, or *Not Active*, press the *Send* (double arrows) key to "wake up" the remote. If the remote still displays *Not Active*, re-enter the Session ID.

- If the Q4RF displays *No Net*, or the Q5RF remote displays *Host not found*, or the Q6RF says *Not Found*, or the Q2RF remote displays -- and turns off, re-enter the Session ID.

- If the Q4RF remote displays *Denied*, or the Q5RF remote displays *Access Denied*, or the Q6RF displays *Session ID Login Denied*, or the Q2RF remote displays --U, the Participant ID is incorrect, or the Remote ID attempting to participate isn’t in the participant list that was loaded. Re-enter the Participant ID, and check to make sure that Remote ID is in the participant list.

**Below are the procedures on how to respond for each question type during**
**presentation for Q2RF remotes:**
- **True/False**- press T or F key.
- **Yes/No**- press Yes or No key.
- **Multiple Choice**- press A, B, C, D, E, or F key.
- **Single Digit Numeric**- enter a single number key.
- **Rating Scale (1-5) or (1-7)**- enter a single number.

**Below are the procedures on how to respond for each question type during presentation for Q4RF and Q5RF remotes:**
- **True/False**- press T or F key and then press the Send key.
- **Yes/No**- press Y or N key and then press the Send key.
- **Multiple Choice**- press A, B, C, D, E, or F and then press the Send key.
- **Multiple Mark**- select multiple letter choices and then press the Send key.
- **Numeric**- enter the numbers and then press the Send key.
- **Sequence**- enter the numbers in the correct order and press the Send key.
- **Short Text Response**- for Q5 remotes only. The alphabet menu will automatically appear when this question type is displayed. Use the arrows on the thumb pad to navigate through the letters, using the Circle key to select the letter(s). Press the Send key to confirm your answer.

**Below are the procedures on how to respond for each question type during presentation for Q6RF remotes:**
- **True/False**- use down arrow to scroll to T or F and then press the Send key.
- **Yes/No**- use down arrow to scroll to Y or N and then press the Send key.
- **Multiple Choice**- use down arrow to scroll to A, B, C, D, E, or F and then press the Send key.
• **Multiple Mark**—use down arrow to scroll to answer choice, click the \( (\downarrow) \) *Menu Select* key to select multiple answer choices, and then press the *Send* key.

• **Numeric**—enter the numeric answer and then press the *Send* key.

• **Sequence**—enter the numbers in the correct order and then press the *Send* key.

• **Short Text Response**—enter in the appropriate answer and then press the *Send* key.

• **Text Response**—enter in the sentence/s answer and then press the *Send* key.

• **Text Edit**—use directional arrows to scroll to the text that needs editing, press *Delete* to remove incorrect character/s, enter correction, and press the *Send* key when finished.

• **Equation**—enter the numeric answer (add special characters by pressing the *Sym* button) and then press the *Send* key.
6.5 Presenting with QVR

You will need to purchase a QVR Presenter license to use this feature. Email info@qwizdom.com for pricing details.

To begin a QVR presentation follow the steps below:

1. Select a PowerPoint presentation and then click Start Presentation to begin setting up a presentation.
2. In the Presentation Setup window, select the presentation options desired (i.e. Participant List, Save Results, and Present As).
3. Click the Device Settings tab. Check Enable Internet-Based Communication. Click OK to present.
4. Login with your credentials. (If you have not registered, click on the ‘New User’ link at the bottom of the window.)
5. The Session ID will appear on the Qwizdom Toolbar. Click on the link to make the QVR Session ID number large. It's helpful to create an instructional slide to help users login in.

6. Instruct participants to login to the QVR session at qvr.qwizdom.com using a browser of their choice; or download the Qwizdom QVR App from the Google Play or Apple App store.
7. In the QVR window, instruct participants to login with the 6 digit QVR Session ID number and then press Launch.
8. Participants maybe asked to enter a User ID if you selected a class list in the Presentation Setup window.

9. Participants will see the presentation via their personal web-enabled device. If the show right/wrong feedback feature is turned on in the Presentation Settings window a green check mark will appear if the participant answered correctly. If an answer is incorrect, a red X will appear.

10. The instructor can display a chart showing the results of all other users currently in the presentation.
11. At the end of the presentation, this window will appear:
6.6 Presenting with Collaboration

Qwizdom Actionpoint software includes 5 Qwizdom Notes+ licenses that allow for classroom collaboration. (Additional licenses are available for a fee--email info@qwizdom.com for pricing.)

Participants can view live lessons, respond, share annotations, take notes, and save presentations for review, using any tablet or laptop on the same local network as the presenter.

Start Presentation

1. Select a PowerPoint®/Actionpoint presentation and click Start Presentation.
2. Select the Device Settings tab in Presentation Setup.

3. Check box to Enable local network communication. (Local communication allows users to connect to the session by IP address. All users must be on the same network as the presenter.)
4. Click OK to start the presentation.
**Participants Join Presentation**

1. On tablets, participants open the Qwizdom Notes+ App (available from the Google Play, Apple App, and Windows Stores).

2. Tap **File** and choose **Join Session**.

3. Enter the local IP address of the presenter's computer--displayed on the feedback response indicator (Q Bar) on the presentation screen (for example 192.168.1.120). [Do not enter the port number (the 4 digits following the colon). For example, if 192.168.1.120:8080 is displayed, do not type '8080'.]

4. Tap **OK**.

Alternatively, if participants do not have the Qwizdom Notes+ App, but have internet-enabled computers, they can type the local IP address of the presenter's computer into a web browser, on port 8080. For example 192.168.1.120:8080. (In this case, the port number '8080' is needed in order to join the session.)

(Note: browser version does not contain the same feature set as the app, such as saving and adding notes.)

**Enable Collaboration**

1. Presenter taps/clicks the Collaboration icon on the feedback response indicator (Q Bar).

2. Window appears in which individual participants can be selected or de-selected.

If participant (class) list is being used, names will be shown. Otherwise, device IDs display.
3. Check box to enable collaboration.
4. Participants selected by the presenter for collaboration then see a Share icon at the top of their Qwizdom Notes+ screen.
5. Collaboration participant annotates or adds text or other objects to the screen, then taps the Share icon.
6. Shared additions are visible to presenter, and all other participants.

**Participants Save Presentation**

Once the presenter has stopped the presentation, the slides will appear on the right-hand side of the participant's screen. At this point, the presentation—including all annotations and added objects—can be saved on the participant's device for future review.

*Please note: this feature is only available with the Qwizdom Notes+ App. It is not an option if connected to the session via web browser.*

1. Tap *File*.
2. Tap *Save*.
3. Type in a file name and tap *OK*. 
6.7  **Response Graph**

During presentation, you can display a response graph to see the results of the question. There are two response graphs you can display: the public response graph and the private graph.

**Private Response Graph using the Q6iRF Instructor Remote**
1. Press the (2) key on the Q6iRF instructor remote.
2. The response graph will display on the LCD screen. Click *Details* to view each participant's response, response time and which students did not respond.
3. Press the (2) key again to close the response graph.

**Public Response Graph using the Q6iRF Instructor Remote**
1. Press the (3) on the Q6iRF Instructor Remote.
2. The response graph will appear on screen for the participants to view.
3. Press the right/left arrows to view a different graph of the results.
4. Press the (3) key again to remove the response graph.

If you have a graph displayed, either on the Q6iRF Instructor Remote or computer, you must first remove that graph before displaying the private response graph and/or move onto the next question.

**Public Response Graph using the Q7RF Tablet**
1. Press the *Public Graph* icon on the Q7RF Tablet.
2. The response graph will appear on the computer screen.
3. Press the *Public Graph* icon on the Q7RF Tablet again to close the response graph.

If you have a graph displayed, either on the Q7RF Tablet or computer, you must first remove that graph before displaying the private response graph and/or move onto the next question.

**Private Response Graph using the Q7RF Tablet**
1. Press the *Private Graph* icon on the Q7RF Tablet.
2. The response graph will display on the LCD screen. View each participant's response, response time and which students did not respond.
3. Press the *Private Graph* icon on the Q7RF Tablet again to close the response graph.

**Public Response Graph using the Q5RF Instructor Remote**
1. Press the / key on the Q5RF Instructor Remote.
2. The response graph will appear on screen for the participants to view.
3. Press the right/left arrows to view a different graph of the results.
4. Press the / key again to remove the response graph.

If you have a graph displayed, either on the Q5RF Instructor Remote or computer, you must first remove that graph before displaying the private response graph and/or move onto the next question.

Private Response Graph using the Q5RF Instructor Remote
1. Press the 0 key on the Q5RF Instructor Remote.
2. A bar chart showing the number of responses will display on the Q5RF Instructor Remote's LCD screen.
3. Press the 0 key again to remove the graph.

Bar Chart
Displays results as a bar chart. Click or press the Bar Chart to change the bars from horizontal to vertical.

Pie Chart Displaying Correct Answer with Number of Responses
Displays results as a pie chart with numbers and the correct response. Click on actual pie chart to show results as whole or in sections.
**Pie Chart Displaying Correct Answer with Percentages**
Displays results as a pie chart with percentages and the correct response.

**Pie Chart Displaying Number of Responses**
Displays results as a pie chart with numbers.
Pie Chart Displaying Percentage of Responses
Displays results as a pie chart with percentages.

List View Chart
Displays results in the order it was received by Remote ID, Participant ID, Participant Name, their response, how long it took for the response to be received, and if their response was correct.
### Scores Chart
Displays results by Remote ID, Participant ID, Participant Name, points, and their current percentage (which is accumulative) for the presentation.

<table>
<thead>
<tr>
<th>Remote ID</th>
<th>Participant ID</th>
<th>Name</th>
<th>Total Points</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>3</td>
<td>Jaci Hendrix</td>
<td>1</td>
<td>100</td>
</tr>
<tr>
<td>12</td>
<td>12</td>
<td>Matt Owens</td>
<td>1</td>
<td>100</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>Dan Kellis</td>
<td>1</td>
<td>100</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>Jenny Madrid</td>
<td>1</td>
<td>100</td>
</tr>
<tr>
<td>8</td>
<td>8</td>
<td>Cathy Roberts</td>
<td>1</td>
<td>100</td>
</tr>
<tr>
<td>5</td>
<td>5</td>
<td>Cielisi Peterson</td>
<td>1</td>
<td>100</td>
</tr>
<tr>
<td>13</td>
<td>13</td>
<td>Participant 01/3</td>
<td>1</td>
<td>100</td>
</tr>
<tr>
<td>7</td>
<td>7</td>
<td>Stephen Boulder</td>
<td>1</td>
<td>100</td>
</tr>
<tr>
<td>6</td>
<td>6</td>
<td>Szie Marsch</td>
<td>1</td>
<td>100</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>Peg Vertor</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>Andy Potter</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>11</td>
<td>11</td>
<td>Neil Bryant</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>
6.8 Games

To display the game animations during presentation:

- Click on the Game icon on the Qwizdom Toolbar.
- Q5RF Instructor--press the (7) Show key.
- Tablet--press the Show icon.

Baseball
Two teams are needed to play Baseball, which the program will automatically group by remote numbers: odd number remotes vs. even number remotes. The outcome of the game depends on the number of correct responses of each team for each question.

1. Click the Start Presentation button.
2. The Presentation Setup window appears.
3. Select a Participant List.
4. Select how you would like to save the results.
5. Click the Present As drop-down arrow and select Baseball.
6. Select the options you would like available during presentation.
7. Click OK to start the presentation.
8. The Baseball setup window will display the odd and even remote numbers in their respective teams.
9. A batter will appear, followed by a question slide.
10. Participants from both teams will send in their responses.
11. The outcome of each play is determined by the number of responses from each team. The game will go in favor of the team with the most correct responses in the least amount of time.
12. The winning team will be displayed when all questions have been answered or when the game has been manually ended.

Fast Track
Fast Track is a race car game in which points are rewarded based on the response time of each remote.

1. Click the Start Presentation button.
2. The Presentation Setup window appears.
3. Select a Participant List.
4. Select how you would like to save the results.
5. Click the Present As drop-down arrow and select Fast Track.
6. Select the options you would like available during presentation.
7. Click OK to start the presentation.
8. A question slide will appear.
9. Participants will send in their responses.
10. Points are awarded by correct responses sent in the least amount of time.
11. The winner will be displayed when all questions have been answered or when the game has been manually ended.

**Mars Mission**

*Mars Mission* is a space ship game in which points are rewarded based on the response time of each remote.

1. Click the **Start Presentation** button.
2. The *Presentation Setup* window appears.
3. Select a *Participant List*.
4. Select how you would like to save the results.
5. Click the *Present As* drop-down arrow and select *Mars Mission*.
6. Select the options you would like available during presentation.
7. Click **OK** to start the presentation.
8. A question slide will appear.
9. Participants will send in their responses.
10. Points are awarded by correct responses sent in the least amount of time.
11. The winner will be displayed when all questions have been answered or when the game has been manually ended.

**Quandary**

*Quandary* is a Jeopardy-like game where users select various dollar amount questions from a game board. 25 slides (questions) are recommended in order to fill the game board.

1. Click the **Start Presentation** button.
2. The *Presentation Setup* window appears.
3. Select a *Participant List*.
4. Select how you would like to save the results.
5. Click the *Present As* drop-down arrow and select *Quandary*.
6. Select the options you would like available during presentation.
7. Click **Settings**. The *Quandary Configuration* window appears. *Quandary Configuration* is where the game options are set up for presentation.
Enter the name of each topic. Each topic represents a category of questions.

Enter the slide numbers related to the particular topic. Each slide represents a different dollar amount in each category (starting from 100 to 500).

Select the scoring option for the game.

You can use pre-existing groups (created in the Participants tab) or have the game create temporary groups (which the program will assign) for the current presentation.

Click OK. You will be taken back to the Presentation Setup window.

8. Click OK to start the presentation.
9. The Team Members screen appears displaying remote numbers in each group.
10. Click Categories to start the game.
11. The game board will display with the categories and dollar amounts.
12. Select a dollar amount from a category. A question slide will appear.
13. Participants will use the remotes to send in their responses.
14. Team points are based on the number of correct responses from each team member. Individual scores are based on how fast the user was able to send in the correct answer because the first remote to send in the correct answer receives all the points for that question.
15. The winning team will be displayed when all questions have been answered or when the game has been manually ended. The individual winner can be determined in the Player Scores screen.
6.9 **Saving Results**

All results are saved as an .QRX file but can be converted into a .CSV file.

**Manual Save**

1. Click the `Start Presentation` button. The `Presentation Setup` window will appear.
2. Select `Save As`.
3. Select a location and name the results file.
4. Click `Save`.

**Auto-save**

1. Click the `Start Presentation` button. The `Presentation Setup` window will appear.
2. Select `Auto Save` and select a location. The file name will contain the document title, participant list, date, and time.
3. The results will save when the presentation has ended.

**Save Results as a PDF or CSV.**

You can save most reports out as a pdf or csv file.

1. Click on the `Report Generator` icon on the toolbar and browse to the results file.
2. Click on the `Download` icon and select Excel or Adobe Acrobat.
7 Reports

You can generate reports* using existing saved results.

*Registered version of Microsoft Excel® is required to generate reports.

1. Click the Report Generator icon. The Reporting Wizard window will appear.
2. Click Browse to search for the file.
3. Click Open.
4. Select the type of report and click Generate.
5. View, Print, or Save as a PDF or Excel document.

Report Features

- **Answer Report**--displays participant information, bar chart, question responses, correct answer and score
- **Answer Distribution Report**--displays total percentage of responses for each question with correct answer and bar chart
• **Score Report**--displays participant information with various point totals and scores
• **Question Summary Report**--displays bar chart next to each question
• **Standards by Question**--displays the standards that are linked to the questions (activity)
• **Standards Mastery Report**--displays percentage of performance in meeting each standard in the activity
• **Question Summary (with Answer)**--Flash-based report displays each question slide with response charts, marking the correct answer in green.
• **Question Summary (without Answer)**--Flash-based report displays each question slide with response charts
• **Participant Detail Report**--displays participant information
• **Participant Group List Report**--displays participant group information
• **Attendance Report**--displays participant information with their remote login time, number of questions answered and total questions
• **Participant Comparison Report**--displays an individual participant's results of an activity
• **Participant Question Summary Report**--displays an individual participant's results with bar chart next to each question
• **Student Standards Report**--displays how the individual participant met each standard in the activity
• **Answer Report (Flash)**--displays each question slide with the user's response and the correct answer

**Export:**
- **Convert to .CSV**--convert .QRX file to .CSV.
- **Gradespeed**--saves .QRX file to .CSV displaying only Participant ID and points
- **Moodle**
- **Blackboard**

**Options:**
- **Override the Point value of all slides to be --- points**--overrides point value that was awarded during presentation.
7.1 Merging Results

Two separate result files generated from the same activity and participant list can be merged to create one results file.

1. Click \(\text{Qwizdom Tools}\), located in the bottom right-hand corner of the screen.
2. Select Utilities.
3. Select Results Merger. The Results Merger window appears.

![Results Merger Window]

4. In the Files to Merge area, click Browse for File 1.
5. Select the .QRX results for File 1.
6. Then click Browse for File 2.
7. Select the .QRX results for File 2 you want to merge with File 1.
8. In the Save As area, click Browse. The Save As window appears.
9. Select a location for the results to save and enter a name.
10. Click Merge. The two files will merge into one and save in the location that was selected with the new name. When it is done, a prompt will appear stating the merge is complete.
11. Click Done to exit the Merge Results window.
8 Answer Key

Grade existing class worksheets, paper-based tests, and textbook material in the Answer Key Mode.

Creating an Answer Key
1. Double-click on the AnswerKey icon to launch the program.
2. Click the Insert a Question button and select the desired question type.
3. Click on the Answer field to set correct answer and advanced grading options (if applicable).
4. Set the number of points.
5. Repeat steps 2-4.
6. When the answer key is complete, go the File menu and select Save. The Save As window opens.
7. Select the location and enter a name.
8. Click Save when done. The answer key will save as a .QAK file.
9. To create another answer key, go to the File menu and select New.

If you delete a question or if the numbering is not in sequential order, go to the Tools menu to select Renumber Questions to correct.

Presenting an Answer Key
1. Go to the File menu and select Open.
2. Select the answer key you want to present and click Open.
3. The answer key appears.
4. Click the Start Session button.
5. The Presentation Setup window appears.
6. Select the Participant List.
7. Select how results will be saved.
8. Select the options you would like available during presentation.
9. Click OK to begin the presentation.
10. Turn on all remotes. The answer key will load into the remote.
11. When all answer keys have been completed, click End Session.
12. You will be taken back to the Answer Key Maker window.
13. The results will be saved in the location you selected.

Presenting Odd-Numbered Questions
1. Go to the File menu and select Open.
2. Select the answer key you want to present and click Open.
3. The answer key appears.
4. Click *Select Odd*. Only the odd-numbered questions will be checked.

5. Click the **Start Session** button.

6. Participants will only answer the odd-numbered questions during their answer key.

**Presenting Even-Numbered Questions**

1. Go to the File menu and select *Open*.
2. Select the answer key you want to present and click *Open*.
3. The answer key appears.
4. Click *Select Even*. Only the even-numbered questions will be checked.

5. Click the **Start Session** button.

6. Participants will only answer the even-numbered questions during their answer key.

**Presenting Selected Question Numbers**

1. Go to the File menu and select *Open*.
2. Select the answer key you want to present and click *Open*.
3. The answer key appears.
4. Check the question numbers you want to present.

5. Click the **Start Session** button.

6. Participants will only answer the selected question numbers during their answer key.

**Presenting Multiple Answer Keys**

1. Go to the File menu and select *Open*.
2. Select an answer key and click *Open*.
3. When the answer key opens, write down the test number (activity ID) located to the right of the title. Participants will need to enter this number into their remotes in order to join the session.
4. Open another answer key and do the same.
5. With both Answer Keys open, click Advanced Session and select Present Multiple (All Open Files).
6. The Presentation Setup window opens.
7. Select a Participant List.
8. Select how results will be saved.
9. Select your presentation settings.
10. Click OK to begin the presentation.
11. Activity ID appears on the participant's remote LCD screen.
12. Participants enter a test number (activity ID) of the answer key into the remote and press the Send key.
13. The answer key will load into the remote.
14. When all answer keys have been completed, click End Session.
15. You will be taken back to the Answer Key Maker window.
16. The results will be saved in the location you selected.

Generating a Report for an Answer Key

1. Click the Report Generator icon. The Reporting Wizard window will appear.
2. Click Browse and search for the saved results and select it.
4. Click Open.
5. Select a report type.
6. Click Generate. See Reports for details.
9 Survey Bar

Survey Bar (without Instructor Remote)
1. Double-click on the Survey icon.
2. The Presentation Setup window appears.
3. Select a participant list.
4. Select how results will be saved.
5. Select presentation mode (Normal or Game).
7. Click on OK to begin the presentation.
8. Turn on all remotes.
9. Reposition Survey Bar, as needed.
10. Click to add a new question then select question type and answer. You may need to expand the Survey Bar to see the question options.
11. Click to pose the question.
12. To Stop posing the question to the remotes, click the blue arrow to expand the Survey Bar. Then, click.
13. At the end of the session, click the Q and select Exit from the drop-down menu.

Survey Bar (with Instructor Remote)
1. Double-click on the Survey icon.
2. The Presentation Setup window appears.
3. Select a participant list.
4. Select how results will be saved.
5. Select presentation mode (Normal or Game).
7. Click on OK to begin the presentation.
8. Turn on all remotes.
9. The Survey Bar will appear at the top of the screen.
10. Press the New Q button on the Q5RF instructor, the (6) on the Q6iRF, or the icon on the Q7 tablet. A list of question types will appear on the LCD.
11. Scroll through the different question types and select desired question.
12. You can select the correct answer and press Send; or press Send without selecting a correct answer (survey).
13. Participants will send their responses.
14. Display results to the group by clicking on the button on the Q5RF, the (3) on the Q6i, or the on the Q7 Presenter Tablet.
15. At the end of the session, click the Q and select Exit from the drop-down menu.
10  **Qwizdom Tools**

*Qwizdom Tools* are located in the lower right-hand corner of the *Windows Taskbar* (next to the clock). *Qwizdom Tools* is a tray application, set to launch automatically on system startup. Qwizdom tools can be used to launch Qwizdom programs or set features on the Tablet.

**Customizing the Qwizdom Tools**

1.   Click \(\text{Qwizdom Tools}\).

   ![Session ID: 209991](image)

   - Actionpoint
   - Qwizdom Answer Key Maker
   - Question Toolbar
   - Content Manager
   - Participants
   - Results / Reports
   - Qwizdom Online
   - Preferences
   - Utilities
   - Hide Menu
   - Exit

2.   Select *Preferences*.

3.   The *Preferences* window appears.
4. Select shortcuts you want displayed in the list and deselect shortcuts that you want to remove from the list.

5. Click OK when finished.

6. Changes take effect immediately.
11 Hot-Key Editor

Hot-Key Editor allows you to program Q7 Tablet actions for a specific software application. The Hot-Key Editor controls the default commands for the soft-keys on the Tablet, allowing users to customize some of the default commands and set up alternate commands.

1. Click Qwizdom Tools.

2. Select Utilities.

3. Select Hot-Key Editor. Hot-Key Manager opens.
List of Actions
These are the actions that can be set for the Hot-Key Editor.

- None
- Open Application
- Open File
- Open Website
- Keystroke
- Keystroke: CTRL +
- Keystroke: ALT +
- Keystroke: CTRL + ALT +
- Keystroke: CTRL + SHIFT +
- Keystroke: ALT + SHIFT +
- Keystroke: CTRL + ALT + SHIFT +

Editing a Key
Soft-keys can be customized to perform specific commands.

1. Click the List Hot-Keys for drop-down list and select the program you want to edit the keys for:
   - Default is Connect: keys 2-8, 19
   - MS PowerPoint is Actionpoint: keys k-13, 16, 19
   - Add New Application: when you add an application, it will be keys 2-13, 16, 19, 32-43, 46, 49

2. Select a key number.

3. Click the Edit button. The Hot-Key Editor will appear.
4. Click the Action Type drop-down list and select the keystroke you want to associate the Action Name (key) with.

   Action Type: Keystroke: CTRL +

5. Then, enter the character in the field below.

   Browse... F

6. Click OK to confirm the key assignment.

**Exporting (Saving) a Hot-Key Configuration File**

You can transfer the Hot-Key configuration file to another computer to save time from reconfiguring the open soft-keys on the Tablet.

1. Click the Save As button. The Save As window appears.

2. Select the save location of the file.
3. Enter the name of the file.

   File name: [enter name]

4. Click Save. The Hot-Key configuration file is saved as .QMP.
Importing a Hot-Key Configuration File

1. Click the **Import** button. The **Open** window appears.
2. Select the **Hot-Key** configuration file you want to import.
3. Click **Open**.
4. The configuration file appears, replacing the currently displayed configuration file in the **Hot-Key Manager** window.
12 Troubleshoot

12.1 Installing USB Drivers

Installing USB Drivers on Windows 7 RF Red Host
You will need to do this procedure twice (because there are two drivers).
1. Download drivers from http://qwizdom.com/files/Drivers.zip and extract them
2. Plug in the host to your USB port.
3. Right-click on Computer and select properties.
4. Click on Device Manager on the left.
5. Qwizdom RF Host should be located under Universal Serial Bus Controllers, Ports and Unknown or Other Devices.
6. Right-click on the driver and select update driver.
7. The installation wizard will appear.
8. Select Browse Computer for Software Driver and click Next.
9. Click on the Browse button. A window appears.
10. Browse your computer and select the USB Drivers Folder
11. Click OK and then Next.
12. When it’s done installing, click on Close. Repeat the above steps once more for USB Serial Port.

Installing the USB Drivers on Vista for the RF Red Host
You will need to do this procedure twice (because there are two drivers). You can download the drivers from our http://qwizdom.com/files/Drivers.zip. Be sure to extract the files before proceeding.
1. Insert the Qwizdom Connect disc into the computer and make sure the host is plugged in properly.
2. From the Start menu, go to the Control Panel.
3. Click Hardware and Sound.
4. Click Device Manager.
5. Select View Devices by Type under the View menu.
6. Qwizdom RF Host should be located under Universal Serial Bus Controllers, Ports and Unknown or Other Devices.
7. Right-click Qwizdom RF Host and select Update Driver. The installation wizard will appear.
8. Select Browse Computer for Software Driver and click Next.
9. Click Browse. The Open window appears.
10. Select the USB Drivers folder.
11. Click OK and then Next.
12. When it’s done installing, click Close. Repeat the above steps once more and then restart your computer.
Installing the USB Drivers on Windows XP for the RF Red Host
You will need to do this procedure twice (because there are two drivers). You can download the drivers from our http://qwizdom.com/files/Drivers.zip. Be sure to extract the files before proceeding.

1. Insert the Qwizdom Connect disc into the computer and make sure the host is plugged in properly.
2. From the Start menu, go to the Control Panel or go to Settings and then Control Panel.
3. Double-click the System icon and click the Hardware tab.
4. Click Device Manager.
5. Select View Devices by Type under the View menu.
6. Qwizdom RF Host should be located under Universal Serial Bus Controllers, Ports and Unknown or Other Devices.
7. Right-click the Qwizdom RF Host and select Update Driver. The installation wizard will appear.
8. Select Install from a list or specific location and click Next.
9. Select Include this location in search boxes.
10. Click Browse. The Open window appears.
11. Select the USB Drivers folder.
12. Click OK and then Next.
13. A prompt will appear that says the drivers have not passed the Microsoft Windows Update testing, click Continue Anyway and then Finish.
14. Repeat the above steps once more and then restart your computer.
12.2 Uninstalling Software and Hardware

Uninstalling Qwizdom Actionpoint
1. Go to Add/Remove programs in the Control Panel.
2. Search for Qwizdom Actionpoint and click Remove.
3. The Install Shield wizard will appear; follow the instructions.
4. Restart your computer for the changes to take effect.

Uninstalling USB Drivers (RF Host)
If the host is still not initializing after following the steps above, then the hardware needs to be completely removed and reinstalled. Follow the steps below.
1. Go to your Control Panel from either your Settings or Start menu.
2. Double-click System and click the Hardware tab or Device Manager tab. If you go to the Hardware tab, click Device Manager key.
3. Search for the Qwizdom RF Host under Universal Serial Bus Controllers, Ports, and/or Other or Unknown Devices.
4. Double-click the file and click the Driver tab.
5. Select Uninstall.
6. Unplug your host after it is uninstalled and go back to the Control Panel.
7. Double-click Add or Remove Programs and search for FTDI Universal Serial Converter Drivers.
8. When you find it, remove the file.
12.3 Toolbar Not Appearing

I just installed Actionpoint but the toolbar is not appearing.

In the Windows version of Actionpoint, opening the program should cause PowerPoint® to open, with an Actionpoint tab added into the PowerPoint® toolbar. If your PowerPoint toolbar does not appear when opening Actionpoint, check to make sure that all Windows and Office updates have been installed on your computer. Install all available Microsoft updates, restart the computer if required then reopen Actionpoint. The toolbar should appear. If you still encounter problems, please email us at support@qwizdom.com.

The toolbar was present, but now disappeared. How do I get it back?
Actionpoint may have closed due to an error and disabled 3rd party add-ins.

Office 2003:

Please contact support@qwizdom.com for help with this version of Office.

Office 2007:

1. Click the Office button at the top left of PowerPoint
2. Click PowerPoint Options
3. Click Add-ins
4. At the bottom, beside "Manage", select Disabled Items and select Go.
5. Enable the Actionpoint Add in and click OK. The toolbar should now reappear.

Office 2010 and Office 2013

1. Click File
2. Click Options
3. Click Add-ins
4. At the bottom, beside "Manage", select Disabled Items and select Go.
5. Enable the Actionpoint Add in and click OK. The toolbar should now reappear.
12.4 Retrieving Error Logs

1. Click **Qwizdom Tools**.

2. Select **Utilities**.

3. Select View Log Files.

4. The location of the error logs will open.

5. Double-click the available folders (number and names of folder will vary).

6. Error logs usually start with the number 6 and are text files. If and when Qwizdom Technical Support request error logs, this is what needs to be emailed.